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1 About Greta

1.1 General Program Description

Greta is used for analyzing gravity retaining walls. It performs two calculations which assess
the overall stability of the wall and the forces in the stem and base.

The calculation for Overall Stability examines the static equilibrium of the wall. The program
assumes that full active and passive soil pressures develop on the virtual boundaries behind
and in front of the wall respectively. The wall is assumed to act as a rigid body together with
any soil encompassed by the vertical planes through the extremities of the wall base.

The total horizontal and vertical forces are resolved to calculate the force on the base of the
wall. The required reaction of the foundation soil is then calculated to provide equilibrium of the
wall. The bearing capacity of the foundation soil is not checked by the program and must be
carried out as a separate calculation by the user.

The location of the resultant force is also checked and reported. If the rotation of the wall due
to the applied force is towards the heel then the calculation is stopped.

The program also calculates the horizontal component of load on the wall and the sliding
resistance of the foundation. The user can specify separate shear strength parameters for the
foundation soil to those used for creation of the active and passive pressures.

Application of factors to loads or soil strengths, to assess the factor of safety of the wall, is at
the discretion of the user.

The calculation for the development of Wall/Base Forces provides shear forces and bending
moments in the stem and base of the wall. The calculation also uses the full active and passive
pressures on either side of the wall. These are applied against the stem and base of the wall
and not at the virtual boundaries. These may be used in the structural design of the wall.

Note : 
Separate soil parameters and anchor loads can be applied to each type of analysis.
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1.2 Components of the User Interface

The principal components of Greta's user interface are the Gateway, Table Views, Graphical
Output, Tabular Output, toolbars, menus and input dialogs.  Some of these are illustrated below.

1.2.1 Working with the Gateway

The Gateway gives access to all the data that is available for setting up a Greta model. 

Top level categories can be expanded by clicking on the `+´ symbol beside the name or by
double clicking on the name. Clicking on the `-´ symbol or double clicking on the name when
expanded will close up the item. A branch in the view is fully expanded when the items have
no symbol beside them. 

Double clicking on an item will open the appropriate table view or dialog for data input. 
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1.2.2 Preferences

The Preferences dialog is accessible by choosing Tools | Preferences from the program's menu. 
It allows user to modify settings such as numeric format for output, show welcome screen, print
parameters and company information. These choices are stored in the computer's registry and
are therefore associated with the program rather than the data file.  All data files will adopt the
same choices

Numeric Format controls the output of numerical data in the Tabular Output. The Tabular
Output presents input data and results in a variety of numeric formats, the format being
selected to suit the data.  Engineering, Decimal, and Scientific formats are supported.  The
numbers of significant figures or decimal places, and the smallest value distinguished from
zero, may be set by the user.  

Restore Defaults resets the Numeric Format specifications to program defaults.

A time interval may be set to save data files automatically.  Automatic saving can be disabled if
required by clearing the "Save file.." check box.

Show Welcome Screen enables or disables the display of the Welcome Screen.  The Welcome
Screen will appear on program start-up, and give the option for the user to create a new file, to
open an existing file by browsing, or to open a recently used file.

Company info The company information button in the preferences dialog box allows external
companies to specify the bitmap and Company name that they would like to appear the top of
the printed output.
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To add a bitmap enter the full path of the file.  The bitmap will appear fitted into a space
approximately 4cm by 1cm.  The aspect ratio will be maintained. 
Note! For internal Arup versions of the program the bitmap option is not available.

Page  Setup  Opens  the  Page  Setup  dialog  allowing  the  style  of  output  for  printed  text  and
graphics to be selected. 
If 'Calculation Sheet Layout´ is selected the page is formatted as a calculation sheet with details
inserted  in  the  page  header.  If  `Logo´  is  selected  the  company  logo  is  inserted  in  the  top  left
corner  of  the  page.  If  `Border´  is  selected  this  gives  a  border  but  no  header  information.  If
`Clipped´ is selected the output is clipped leaving a space for the logo. This has no effect on text
output. 

1.3 Program Features

The main features of Greta are summarised below:

· Structural Types : A number of different wall shapes may be specified, with tapering and/or
sloping stem, and optional base, toe, heel and key.  
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Note : The wall is assumed to be rigid and can only be made of one material type with a single
specified unit weight.

· Soil Strata : The program allows a number of different soil strata to be specified behind and
in front of the wall. The ground surface behind the wall may be specified as sloping. The
surface in front must be horizontal. 

· Soil Coefficients : Different soil coefficients may be specified for the calculation of Wall/
Base Forces and Overall Stability.

  
· Ground Water Pressures : The groundwater pressure distribution may be defined as a

'hydrostatic' or piezometric.  
· Uniform Surcharges : These act vertically and may be included behind and in front of the

wall. 

For the Overall Stability Analysis, surcharge loads are taken into consideration only in so far as
they increase lateral earth pressures. They are not directly included in the equilibrium analysis. 

· A line load, acting at the centre of the top of the wall, may also be specified.  
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· Ground Anchors can be added down the stem of the wall. Each anchor can have a different
inclination, elevation and anchor force.

   The last four parameters above may be specified differently for each stage of the analysis.



Methods of
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2 Methods of Analysis

2.1 General

Greta performs two analysis to determine the overall stability of the wall and the forces in the
stem and base. The user may decide whether or not to carry out the latter.

The shear forces and bending moments calculated for the stem and toe and heel of the base
can be used as the basis for structural design.

2.1.1 Overall Stability

The calculations for overall stability use the soil pressure profiles derived for the virtual
boundaries on back and front of the wall.

Full active and passive earth pressures are calculated to determine the overall equilibrium of
the wall.

For the soil behind the wall the active earth pressure is calculated using the soil coefficients ka

and kac. The passive pressures in front of the wall are calculated using the corresponding

values of kp and kpc. The vertical components of friction and adhesion, for the front and back,

are also included.

Soil and water pressure profiles are calculated for the full depth of the wall, including the shear
key if present. These forces are used in the check for sliding and determination of the area and
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pressure in the stress block.

Vertical forces

General Back Front
Weight of wall
(including key)

Anchor forces

Water pressure under
base

Line load on top of wall

Weight of soil above heel

Shear on virtual back

Shear on back of base

Weight of soil above toe

Shear on virtual front

Shear on front of base

   

Note : Vertical shear forces for the depth of the shear key and surcharges confined by the area
of the base, are not included.

Horizontal forces

General Back Front
Anchor forces Soil pressure (virtual

back)

Water pressure

Soil pressure (virtual
back)

Water pressure
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The total horizontal and vertical forces are resolved to provide an overall resultant force. The
location of the intersection of the force with the base is given, including whether the force is
located within the middle 1/3 or outside the area of the base.

Unstable configurations for the wall would be:
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The calculation is also stopped if the rotation of the wall is towards the heel.

In this situation the active and passive pressures will be reversed and therefore the given
calculation becomes invalid.
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2.1.1.1 Plastic stress block / Bearing capacity failure

The plastic stress block is defined as the area of plastic deformation beneath the wall.

The total horizontal and vertical forces, calculated for overall stability, are resolved to provide
an overall resultant force. The intersection of the resultant with the base of the wall is used to
locate the centre of the plastic stress block. The total width of the stress block is defined as
twice the distance of the intersection of the resultant force from the toe of the wall at A.

The vertical soil stress within the block is taken as Rv / 2x

horizontal soil stress as Rh / 2x

The user must check independently whether the stresses in the block would lead to bearing
capacity failure. Appropriate shape, depth and inclination factors should be used in the
calculation.

2.1.1.2 Sliding check

A check is made on the sliding resistance of the wall using the total horizontal force calculated
for overall stability.

The allowable resistance Rs is taken from the input foundation properties where,

Rs = RvTand + cw Ab

Rv = Resultant vertical force (Overall stability)  

d  = Soil/Base friction angle
cw = Cohesion under base

Ab = Area of base or stress block (length per unit width).

Note : If it is found that horizontal equilibrium is not achieved, then it is
assumed that any additional horizontal force will be mobilised at the shear
key. The user must satisfy themselves that the ground would be able to
withstand the computed force.
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2.1.2 Wall and Base Forces

The calculations for Wall / base forces use the soil pressure profiles derived directly on back
and front of the wall.

For the soil behind the wall the active earth pressure is calculated using the soil coefficients ka

(w) and kac(w). These values should allow for compaction stresses where appropriate. The

passive pressures in front of the wall are calculated using the corresponding values of kp(w) and

 kpc(w). These values are not necessarily the passive pressure coefficients of the soil, but can

be used to define the stresses the user wishes to be applied to the front of the wall.

Soil and water pressure profiles are calculated for the full depth of the wall, including the shear
key if present. These forces are used in the calculation of the pressures beneath the base of
the wall and the shear force and bending moments in the stem and base.

The horizontal soil pressures underneath the base are taken at the virtual boundaries In
reality, the restraining force available from a shear key may be greater than this. The user may
choose to model this effect by modifying the value assigned to the strength of the soil in front
of the wall.

Vertical forces

General Back Front
· Weight of wall (including

key)
· Anchor forces
· Water pressure under base
· Line load on top of wall

· Weight of soil above heel
· Shear on back of wall
· Shear on back of base
· Surcharge above heel
· Soil pressure (inclined back)
· Water pressure (inclined

back)

· Weight of soil above
toe

· Shear on front of wall
· Shear on front of base
· Surcharge above toe
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Note : Vertical shear forces for the depth of the shear key are not included.

Horizontal forces

General Back Front
· Anchor forces · Soil pressure on back of

wall
· Water pressure
· Shear force (inclined back)

· Soil pressure on front of
wall

· Water pressure
· Shear force (inclined front)

The total horizontal and vertical forces are resolved to provide an overall resultant force. The
location of the intersection of the force with the base is given, including whether the force is
located within the middle 1/3 or outside the area of the base.

Unstable configurations are as for the overall stability calculations, see Overall Stability.

Note : If the rotation of the wall is towards the heel then the calculation is stopped and a
warning provided.

The soil and water pressure profile beneath the base is calculated as follows:
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Where

B = width of base
e = eccentricity of resultant R from centerline of base.

The water pressure beneath the base is taken as linear profile between the water levels at the
front and back of the wall. This pressure profile is increased accordingly over the width of the
shear key.
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2.1.2.1 Shear key

The forces in the shear key are determined from the summation of the horizontal pressures
acting down the virtual front and back of the wall beneath the base and the total vertical and
horizontal forces calculated for the assessment of the forces in the stem and base.

The following table defines the reported calculations.

Net force on key Fnet = (Ppsk – Pask)

Resultant horizontal
force
(Wall / base forces)

Rh

Allowable shear on
base
(Wall / base forces)

Sb = (Rv - U)tand + cw Ab

Additional force on
shear key

Fsk = (Rh – tb) if Rh > tb else Fsk = 0

Assumed lever arm
of additional force

la = 2/3 depth of the key (h)

Total horizontal
force on key

Rhsk = (Ppsk – Pask) + Fsk

Lever of action of
total force

lsk =

Bending moment in
key

BMsk = Rhsk * lsk
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Note : The above assumes that the shear key is capable of providing the horizontal force
required to give horizontal equilibrium. The user needs to check that the soil in front of the key
is capable of sustaining this force.

2.1.2.2 Bending moments and shear forces

The bending moments and shear forces are calculated at specified sections down the wall and
along the toe and heel of the base.

The location of the shear key is checked and the spacing of the increments adjusted to place a
point at either side of the key, as shown.

The shear forces are calculated from the summation of the vertical and horizontal forces acting
on the stem and base as follows:

Horizontal forces on stem · Soil pressures
· Water pressures

Vertical forces on base Downward
· Friction at heel on base
· Weight of soil on toe or heel
· Weight of base slab
· Surcharges
· Weight of shear key
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Upward
· Friction at toe on base
· Soil pressure beneath base
· Water pressure beneath base

Any horizontal forces on the stem due to friction are not included.

The bending moments are calculated by taking a lever arm from the top of the stem and the
toe and heel ends of the base slab respectively. The moment due to any horizontal force on
the shear key is also included in the calculation for the bending moments in the base.

2.1.3 Earth Pressures

The active and passive earth pressures are calculated at the top and base level of each
stratum and at intermediate levels where there is a change in linear profile of pressure with
depth e.g. location of phreatic surface.

Intermediate levels are also placed at the top and underside of the wall base and bottom of the
shear key. The effective active and passive pressures normal to the wall are denoted by p'a
and p'p respectively. These are calculated from the following equations:-

p'a = ka s'v - kac c'

p'p = kp s'v + kpc c'

Where,
c = effective cohesion or undrained strength, as

appropriate
s'v = vertical effective overburden pressure

Note : Modification of the vertical effective stress due to wall friction should be made by taking
appropriate values of ka and kp

ka and kp = horizontal coefficients of active and passive pressure

kac and kpc = cohesive coefficients of active and passive pressure

   
Note : For conditions of total stress ka = kp = 1.

For a given depth z

Where,   
gs

= unit weight of soil

u = pore water pressure
szudl

= vertical sum of pressures of all uniformly distributed loads (udls) above depth z.

A minimum value of zero is assumed for the value of (ka s'v - kac c').
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2.1.3.1 Friction and adhesion

Stresses due to friction are calculated are the virtual and front of the wall for assessment of
overall stability and at the wall surface for calculation of the forces in the stem and base.

Overall Stability

For the virtual back and front and ends of the wall base the tangential stresses are taken as:

boundary friction (active)   =  p'a tan f0

boundary friction (active)   =  p'p tan f0

boundary adhesion   =  c0h

Where,
f0 = specified boundary friction for overall stability

c0 = specified boundary cohesion for overall stability

Wall / base forces

Where the wall stem remains vertical the friction calculation at the wall interface (stem and
base) is the same as for overall stability, but uses the friction parameters given for calculation
of the wall/base forces.

Where the wall stem is inclined the calculations for the friction forces are separated into their
horizontal and vertical components, where;

Friction

horizontal friction (active) = p'a tanyb tanfw

vertical friction (active) = p'a tanfw

horizontal friction (passive) = p'p tan yf tanfw

vertical friction (active) = p'p tanfw

Where,
y = angle of the wall stem to the vertical (front and back)
f = specified friction for wall / base forces

Adhesion

horizontal cohesion (active) = p'a tanyf cw

vertical cohesion (active) = p'a cw

Use p'p for passive equations.

cw = specified wall adhesion for wall / base forces

For information on friction beneath the base of the wall see, Sliding check.

2.1.4 Bearing Capacity

Terzaghis equation

Uult = CcNcdcic + qNqdqiq + 0.5 gBeff Ngdgig

Uult Ultimate bearing capacity of soil
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Cc Cohesion between Soil ground and wall

q Effective stress in front of wall

g Unit weight of soil above the base level
B Effective width of wall based on horizontal surface
f Angle of internal friction

Nc, Nq, Ng Dimensionless bearing capacity factors

dc, dq, dg  Dept factors

ic, iq, ig     Inclination factors

Calculation of effective stress (q)

Effective stress is the cumulative sum of weight of soil in front side of the wall minus water
pressure under base

Effective width of wall (B)

The entire load acting from above is combined into two component forces having V as
the vertical component and H as horizontal component.
The effective width of the foundation is such a way that its geometric center coincides its
load center or the width of the plastic stress block, i.e. if the vertical component
intersects the base at a distance a from the toe then the width of the base is 2a

Dimensionless factors used in Terzaghi's Equation

These are derived using two theories 
a) Brinch Hansen Theory
b) Meyerhof Theory

Brinch Hansen Theory Meyerhof Theory

Bearing capacity factors

Nq = tan2(45+f/2)ep tan f

Nc = 5.14                 if f = 0

    = (Nq-1) / tan f     if f > 0

Ng = 1.8 (Nq-1) tan f

Bearing capacity factors

 Nq = tan2(45+f/2)ep tan f

Nc = 5.14                 if f = 0

    = (Nq-1) / tan f     if f > 0

Ng = (Nq-1) tan 1.4f

Inclination Factors

iq = 1 - [ (0.5 H) / (q+ B c cot f) ]5

ig = 1 - [ (0.7 H) / (V + B c cot f)]5

ic = [1- (V / B c)2 ] / 2    if f = 0

   = iq - (1-iq) / (Nq-1)      if f > 0

Inclination Factors

q = tan-1 (Sum of Horr. forces / Sum of Vert.
forces)

f = 0 f > 0
iq = 1 - (q / 90) iq = [1 - (q / 90)]2

ig = 1 ig = [1- (q/f)]2 if q£f

   = 0             if q>f
ic = 1 - (q / 90) ic  =  [1 - (q / 90)]2
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Depth Factors

k = Depth / Width of footing 

f = 0 f > 0
dq = 0.4 k dq = 1+ 0.4k

dg = 1 dg = 1

dc = 1 dc = 1+ 2 tan f (1-

sin f)2 k

Depth Factors

k = Depth / Width of footing
Nf =  tan2(45+f/2)

f = 0 f > 0
dq = 1 dq = 1+ 0.1 (Nf)

1/2 k 

dg = 1 dg = 1+ 0.1 (Nf)
1/2 k 

dc = 1+ 0.2 (Nf)
1/2 k dc = 1+ 0.2 (Nf)

1/2 k 

2.1.5 Base Optimisation

Greta provides a tool to optimise the base width by iterating the base width to achieve the
minimum possible width giving full mobilization of soil strength , the wall is checked for sliding,
overturning, bearing, and uplift using the factors of safety provided by the user.

The tool can be used to optimise the base width, and also find the minimum toe or heel width
required for heel or toe width specified respectively.

To see how to use this tool please refer to Base optimisation tool
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3 Input

3.1 Assembling Data

It is best to make a sketch of the problem before the computer is approached . This should
comprise a cross section of the proposed wall with the:

· ground surface level and inclination  

· location of each soil strata  

· parameters of each material (Overall stability and wall/base forces)  

· foundation material parameters  

· phreatic surface  

· location of any piezometers  

· magnitude of any loads  

· location of any anchors.

3.2 Opening the Program

The following provides details of all the data required to run the Greta program.

On selection of the Greta program the main screen will open.
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This is the main screen within which all data, graphics and results are entered and viewed. All
further information appears in a series of smaller or "child" windows, which are placed inside
the main screen.

To start a new project file select :
· The "Create a new data file" option on the opening screen

· File | New or  the icon .
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This will open a new Titles window and allow you to proceed.

It is possible to open more than one data file at any one time. The file name is therefore
displayed in the title bar at the top of each child window.

3.2.1 Intranet link and emails

To view the latest information regarding the Greta program or contact the support team click

on the internet   or support team buttons on the Start screen or select the options
from the toolbar. 

List of information required and actions before contacting support team: 
· Version of Greta (see top bar of program or Help | About Greta)
· Spec of machine being used
· Type of operating system
· Please pre-check all input data
· Access help file for information
· Check web site for current information
· Should you report a program malfunction then please attempt to repeat and record process

prior to informing the team.

The web site aims to remain up to date with all data regarding the program and available
versions. Should any malfunctions persist then the work around or fix will be posted on the web
site. 

In addition, if the user wants to email the input file that he/she is currently working on, to the
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support team, he/she can do so by clicking File|Email... button.

3.3 Data Input Screens

Data is input via the Data menu or the Gateway.

The information can be entered in any order, but Material Properties should be entered before
specifying Material Layers.

Once the data has been entered the program places a tick against that item in the menu list.

The following describes each of the menu items in detail.
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3.3.1 Titles

The first window to appear, for entry of data into Greta, is the Titles window.

This window allows entry of identification data for each program file. The following fields are
available:

Job Number 
allows entry of an identifying job number.

Initials 
for entry of the users initials.

Date 
this field is set by the program at the date the file is saved.

Job Title 
allows a single line for entry of the job title.

Subtitle 
allows a single line of additional job or calculation information.

Calculation Heading 
allows a single line for the main calculation heading.

The titles are reproduced in the title block at the head of all printed information for the
calculations. The fields should therefore be used to provide as many details as possible to
identify the individual calculation runs. 

An additional field for notes has also been included to allow the entry of a detailed description
of the calculation. This can be reproduced at the start of the data output by selection of notes
using File | Print Selection. 
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3.3.1.1 Titles window - Bitmaps

The box to the left of the Titles window can be used to display a picture beside the file titles.
To add a picture place an image on to the clipboard. This must be in a RGB (Red / Green /

Blue) Bitmap format. Select the  button to place the image in the box.

The image is purely for use as a prompt on the screen and can not be copied into the output
data.

Note : Care should be taken not to copy large bitmaps, which can dramatically increase the
size of the file.

To remove a bitmap select the  button.

3.3.2 Units

The Units dialog is accessible via the Gateway, or by choosing Data | Units from the program's
menu.  It allows the user to specify the units for entering the data and reporting the results of
the calculations.  These choices are stored in, and therefore associated with, the data file.

Default options are the Système Internationale (SI) units - kN and m.  The drop down menus
provide alternative units with their respective conversion factors to metric.

Standard sets of units may be set by selecting any of the buttons: SI, kN-m, kip-ft kip-in.

Once the correct units have been selected then click 'OK' to continue.
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SI units have been used as the default standard throughout this document.

3.3.3 Analysis Options

The analysis options allows the user to specify the number of sections, down the stem of the
wall and along the toe and heel of the base, to be taken for calculation of the shear forces and
bending moments.

If the box for "Include derivation of wall/base forces" is checked then the calculation for shear
forces and bending moments will proceed. Otherwise they will not be reported.
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3.3.4 Wall Geometry

The geometry of the wall and wall weight must be defined here.
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3.3.5 Material Properties

The properties for the different materials, on either side of the wall, are entered in tabular form.
For the data input select 'Material Properties' from the Data menu or the Gateway.

Brief descriptions for each of the material types can be entered here. You need, however, to
remain aware of the material number given to each of the material types. This is located, as a
default value, in the left hand column. This number is used when assigning material types to
either side of the wall, thereby creating the Material Layers.

General parameters for each material are entered on the first page of the table.

Individual parameters for each of the methods of solution must then be entered. The relevant
tables are accessed by moving the mouse over the tabs at the bottom of the table and clicking
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the left mouse button.

Material Properties for Overall Stability

Material Properties for Wall / Base Forces

Overall stability Wall/Base
forces

Description

Virtual boundary
friction

Soil / Wall friction Angle of friction in degrees

Virtual boundary
adhesion

Soil / Wall
adhesion

Adhesion cw

ka k Active earth pressure

kac kc Active earth pressure due to cohesion

kp kpw Passive earth pressure

kpc kcw Passive earth pressure due to cohesion

On occasions the user may wish to model an excavation in front of the wall. This can be
achieved by including a soil type 'Air' in front of the wall. Parameters chosen should use a
minimal bulk unit weight, (e.g. 0.01 KN/m3), low shear strength (e.g.f = 1.00), and coefficients
K(e.g. 0.1). This will help to provide minimal passive resistance in front of the wall.

3.3.6 Material Layers

The level of the base of each material layer must be entered. The levels can be different on
either side of the wall only to the level of the underside of the base slab. Material Layers
can be entered by selecting 'Material Layers' from the Data menu or the Gateway.
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Beneath the base slab the same soil type must be selected for both sides of the wall. Only one
soil type is analysed for siding and reaction on the shear key.

For each material layer, the level of the base of the layer and the material type must be
entered. The material type is selected from a drop-down list of all the descriptions entered in
the Material Properties module.

3.3.7 Foundation Properties

The soil levels in front of and behind the wall, and the angle of the soil surface behind the wall,
are entered here. The foundation properties used to assess the wall stability against sliding
should also be entered. Foundation properties can be entered in tabular form by selecting '
Foundation Properties' from the Data menu or the Gateway.
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3.3.8 Groundwater

Groundwater data for the front and back of the wall is entered. Different levels and pressures
can be used for assessment of the overall stability and wall / base forces. The value of the unit
weight of water is, however, a global value for all piezometers. Groundwater can be entered in
tabular form by selecting 'Groundwater' from the Data menu or the Gateway. 

If only one data point is entered for either side of the wall, the program will assume a 
hydrostatic groundwater distribution on that side of the wall. The pressure specified at the
point need not necessarily be zero. For the first point on each side of the wall, the unit weight
of water must also be entered.

For hydrostatic distributions the water pressure (u) is calculated from

u = zwgw

Where,   
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zw is depth below water table level, and

gw is  specified unit weight of water. 

Thus a partial hydrostatic condition can be modelled by specifying a value of gw less than

10kN/m3.

Note : All defined water pressures are assumed to extend laterally from either side of the wall.
For piezometric profiles the level and pressure at each known point must be entered. If more
than one data point is entered, the program will assume that the points represent piezometers,
and the groundwater pressure will be interpolated vertically between the specified points.
Below the lowest point, groundwater pressure will be assumed to extend hydrostatically.

The groundwater pressure beneath the base slab is assumed to have a linear profile between
the elevations at the front and back. Groundwater flow beneath the wall is not modelled.

3.3.9 Surcharges

Uniformly distributed surcharges can be placed on the surface of the soil on either side of the
wall. A line load can also be placed at the centre line of the wall stem. Surcharges dialog can
be invoked by selecting 'Surcharges' from the Data menu or the Gateway.

3.3.10 Anchor Loading

Anchors can be placed in the stem below the ground level at the back of the wall and above
the top of the base slab. Anchors can be entered in tabular form by selecting 'Anchor Loading'
from the Data menu or the Gateway.
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Each anchor can have a separate force applied for analysis of overall stability and wall / base
forces. A single angle to the horizontal is required.

Anchor forces can also be used to represent forces in shores and struts.

Note : Users must satisfy themselves independently that the anchor systems are capable of
sustaining the specified forces.

3.3.11 Base Optimisation Tool

The base width optimisation for optimum utilization of external properties can be carried out

using the base optimisation tool, this can be accessed by clicking the  on Greta toolbar or
from Tools | Optimise base from Data menu
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The tool dialog box is divided into three sections
· Initial Geometry of wall that shall be edited only if the optimised results are accepted by the

user,
· The optimisation and editing section where the user can specify different heel and tow width

and optimise the other for the one he has specified
· And the "Comparison of results" sheet
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4 Output

4.1 Analysis and Data Checking

Results can be obtained by selection of the Analysis menu.

Prior to analysis the program carries out a data check.

The data checks carried out are as follows:
· The material layers beneath the base slab are the same between the front and back.  
· The anchors are all placed at or below ground level and above the top of the base.  

If no errors are found then the calculation can proceed. Select OK.

Note: The option to Delete results becomes available once the calculations have been
completed.

4.2 Tabular Output

Tabular Output is available from the View menu, the Gateway or the Greta toolbar. The results
are provided in both a full and condensed tabular form. The lists of tabulated output can be
highlighted and then copied to the clipboard and pasted into most Windows type applications e.
g. Word or Excel.  The output can also be directly exported to various text or HTML formats by
selecting Export from the File menu.
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4.3 Graphical Output

Graphical output is accessed via the view menu using View | Graphics | Overall Stability and 
View | Graphics | Wall / Base Forces buttons, the Gateway or the Greta Toolbar.
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The graphical representation of the soil layers, the retaining wall,  and surcharges is shown
here.

This window has a toolbar which has buttons corresponding to different physical quantities like
active and passive pressures, porewater pressure, soil layers and, bending moment and shear
force diagrams.

When the user makes the appropriate selection, the corresponding plot is shown. 

The plot can be exported in WMF format.
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6 Manual Example

6.1 General

The data input and results for the Greta manual example are available in the 'Samples'
sub-folder of the program installation folder. The example has been created to show the data
input for all aspects of the program and does not seek to provide any indication of engineering
advice. 

Screen captures from this example have also been used throughout this document.

This example can be used by new users to practice data entry and get used to the details of
the program.
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7 Brief Technical Description

7.1 Greta

Greta is used for analyzing gravity retaining walls. It performs two calculations which assess
the overall stability of the wall and the forces in the stem and base.

The calculation for Overall Stability examines the static equilibrium of the wall. The program
assumes that full active and passive soil pressures develop on the virtual boundaries behind
and in front of the wall respectively. The wall is assumed to act as a rigid body together with
any soil encompassed by the vertical planes through the extremities of the wall base.

The total horizontal and vertical forces are resolved to calculate the force on the base of the
wall. The required reaction of the foundation soil is then calculated to provide equilibrium of the
wall. The bearing capacity of the foundation soil is not checked by the program and must be
carried out as a separate calculation by the user.

The location of the resultant force is also checked and reported. If the rotation of the wall due
to the applied force is towards the heel then the calculation is stopped.
The program also calculates the horizontal component of load on the wall and the sliding
resistance of the foundation. The user can specify separate shear strength parameters for the
foundation soil to those used for creation of the active and passive pressures.

Application of factors to loads or soil strengths, to assess the factor of safety of the wall, is at
the discretion of the user.

The calculation for the development of Wall/Base Forces provides shear forces and bending
moments in the stem and base of the wall. The calculation also uses the full active and passive
pressures on either side of the wall. These are applied against the stem and base of the wall
and not at the virtual boundaries. These may be used in the structural design of the wall.
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